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Hello friends, welcome back to this online certification course on Watershed Hydrology. I am 

Rajendra Singh, a professor in the Department of Agriculture and Food Engineering at the 

Indian Institute of Technology Kharagpur. We are in module 7, this is lecture number 3.  



 

 The topic is morphometric analysis using RS and GIS, which stands for remote sensing and 

GIS. The contents of this lecture include morphometric analysis, watershed delineation, 

watershed geomorphology using QGIS software, and how to determine linear aspects, aerial 

aspects, and relief aspects using the QGIS software. 

 

 Morphometric analysis involves the quantitative measurement and analysis of the shape, size, 

and relief characteristics of the drainage basin. We have already studied the geomorphological 

characteristics in the previous lecture. 

When we attempt to quantitatively determine these characteristics related to the shape, size, 

and relief of the watershed, we call that morphometric analysis. This analysis is essential for 

various applications including water resources management, flood prediction, and 



environmental planning. All the watershed features or characteristics can be studied using 

morphometric or geomorphological characteristics. Remote sensing and geographic 

information systems (GIS) play crucial roles in the morphometric analysis of drainage basins, 

providing valuable tools for studying and understanding the characteristics of river networks 

and watersheds. So, using remote sensing and GIS, many tools are available. Remote sensing 

provides the data, and GIS helps us in analyzing the data. 

So, RS and GIS tools facilitate the extraction of morphometric parameters from digital 

elevation models, satellite imagery, and other geospatial datasets. We discussed earlier that 

geomorphological characteristics can be determined easily if we have a drainage map and a 

contour map. When we mention DEM, it refers to a contour map, essentially having surface 

elevation available. Using this DEM, we can generate the drainage network using any QIS 

software and thus extract various geomorphological characteristics of the watershed. 

 

 Just to give you a brief overview, remote sensing involves the acquisition of information about 

the Earth's surface without direct physical contact. We use sensors either on satellites or radars, 

and nowadays drones are also being used extensively. 

Satellite and aerial imagery are common sources of remote sensing data for morphometric 

analysis. These images provide high-resolution spatial data that can be used to identify and 

map landforms, rivers, and other features within the drainage basins. Similarly, GIS is a 

powerful tool for spatial analysis and data visualization. It integrates various geospatial 

datasets, including satellite imagery, topographic maps, and hydrological information. It 

enables the creation of accurate and detailed maps of drainage basins, providing a platform for 

morphometric analysis. 

 

"So, these are quite useful in hydrology, as all geomorphological features can be studied live 

using remote sensing data and GIS tools. 



 

 Now, let's talk about watershed delineation, which is the process of identifying the boundary 

of a watershed, typically drawn on a topographic map using information from contour lines. 

As we mentioned, contour lines and drainage lines on topographic maps help us delineate 

watersheds we are interested in. Further information can be obtained using remote sensing and 

GIS tools, as mentioned earlier. This lecture will be more of a tutorial, where I will provide 

step-by-step instructions. I encourage you to download the data and software and give it a try. 

For those who have already done this, that is fine. But for those who have not, I think you will 

find it exciting and informative. To carry out watershed delineation using GIS software, we 

need a digital elevation map (DEM) of the watershed.  

 



Digital elevation models for any region can be freely downloaded from the USGS Earth 

Explorer website. You need to create an account and sign in to access the website. Once signed 

in, you will see this user interface. 

 

Click on the 'Polygon' sub-tab to select the DEM of the area. You will need to select different 

points of the polygon based on the latitude and longitude of the study area, at least 4 points, as 

shown pictorially here. 

 

 Then, click on the 'Dataset' tab to choose the satellite and DEM. Look for 'Digital Elevation' 

under the dataset tab, and then select 'SRTM' (Shuttle Radar Topography Mission). SRTM 

DEMs are popularly used and freely downloadable. Select SRTM, then click on SRTM 1 and 

'Results'.  



 

You'll see the generated results with available tiles for the area and specific day. Click on the 

download icon here to download the tiles." 

 

"Now, for downloading, we select the TIFF file, which is a GeoTIFF file as we have written 

here. So, we have a DEM of the watershed for further processing. We have downloaded the 

DEM of the area of interest from the USGS website.  



 

Now, this DEM can be processed using any GIS software. Of course, the most popular one is 

ArcGIS, and then there is QGIS. ArcGIS is very expensive, while QGIS is freeware, as I said, 

it is a free GIS software, and it can be downloaded from this site. This is the address, so you 

can download it freely from this site. This is the download button. 

 

Now, this is the graphical user interface of the QGIS software. To carry out the watershed 

delineation, we need to add the downloaded DEM to a project. Here, we select the 'Layer' tab, 

then the 'Add Layer' tab, click on 'Add Raster Layer', and then we add the downloaded DEM 

file. This is the DEM file where you have saved it, which you must include. 



 

 Two tiles of the DEM will be displayed here, as we saw while downloading, that there are 2 

tiles we have downloaded. 

These 2 tiles need to be merged to create 1 DEM file. For that, we look for the 'Merge' tool in 

the Processing Toolbox or type 'merge' to get the merge tool and click on that. So, either you 

can go directly to the toolbox or you can search for 'merge' here, and then you will be taken to 

the toolbox.  

 

After opening the merge tool, add 2 DEM tiles and click on the 'Run' button. So, we use the 2 

tiles and keep the run in the background, and this is the merged DEM. So, we get the merged 

DEM here. 



 

Now, we set the geographic projection of the DEM. For that, we select the 'Raster' tab here, 

then we select the projection and select the 'Wrap Projection'. 

 

 And of course, we must select the input DEM first. So, we will select the merged DEM here, 

and then, of course, we must choose the target CRS or coordinate reference system which is 

WGS 84 UTM zone 45 N. After clicking the target CRS, another window will open where we 

will choose this, and then, of course, we will run it in the background.  



 

Then, once we have done that, the very first when we downloaded the DEM, there are plenty 

of sinks available. So, we must do the sink filling. After the projection, the first step in 

watershed delineation is filling the sinks. For that, we need the Fill Sink tool. 

 

As already mentioned, we can search, or you can directly go if you are an experienced user. Of 

course, you can search for this, and then after opening the Fill Sink window, the reprojected 

DEM file is given as inputs here, as you can see the reprojected one. We specify the Fill DEM 

and flow direction output file location, which is here, and we uncheck the watershed basins 

here, and finally, we run the application.  



 

After running the application, we must fill DEM, and right-click, then go to the properties. This 

is the fill DEM we have got. You go to the properties and click on symbology here, then change 

the render type and colour ramp, that is basically, we change the colour ramp to show how your 

projection will look. And then, basically, we click OK.  

 

So, this is the fill DEM after changing the colour ramp. This is how, you know, we downloaded 

DEM and now it is here with the colour after filling the sink and after getting this colour ramp, 

this is how it looks. 



 

So, now, the next thing that will come is stream ordering. In the stream ordering, we use 

Strahler stream ordering, which we are choosing. Strahler stream ordering is a more popular 

one. For stream ordering, fill DEM is the input layer here. Then we specify the output path, 

then we click on the 'Run' button, and then click on the Strahler order and right-click, to go to 

the properties. 

 

 So, Strahler orders right-click and goes to the property. So, you will get this, go to the 

symbology earlier, like we went for colour changing, and change the render type and colour 

ramp to visualize the different order of streams. So, this is the colour ramp we are choosing, 

and so different values will be shown with different colours, and then we press OK. 



 

 So, stream order varies from 1 to 11, as you can see here, 1 to 11, is showing stream order, and 

this is what it is showing in the picture here also, and we choose a threshold value for the major 

stream. 

So, we may not be interested in that final division; we may put a threshold value. 

 

 So, for that, we choose the major streams here and click on the 'Raster' tab, major streams, and 

click on the 'Raster' tab, then click the 'Raster Calculator' here, and then the 'Raster Calculator', 

double-click on the Strahler order. So, double-click on the Strahler order here and choose the 

threshold value. So, we can choose the threshold value that we want maximum of 7 or less than 

equal to 7 or whatever I mean, we can choose depending upon the area information we have.  



 

So, these are the major streams that are being shown now, and as you can see, the number has 

gone down now." 

 

Now, once we have the channel network and drainage basin, that is what we will go for once 

we have selected the order. So, here we go to the channel network and basin. In the channel 

network and drainage basin tool, we input the field DMA's input, which is here, and check on 

the channels and drainage basins. So, chain drainage channels and drainage basin here.  



 

So, it is here, and then we press OK, and the channels and drainage basins are visualized. You 

can see here different channels and drainage basins also they are being remarked. Choose a 

drainage basin and point out the outlet of the basins. 

Now, we can decide which basin we want to work within that area. So, different basins. Let us 

say that we selected this basin, which is being shown here. This is the basin let us say we are 

selecting, and this is the outlet of the basin let us say this is the outlet of the basin. So, for 

creating the outlet point and outlet point shape file needs to be created, and for that click on the 

layer, then go to create a layer, and then click on the new shapefile layer here. 

 

Once we do that then in the new shapefile layer window put the output file name, we need to 

put an output file name in some shapefile then choose geometry type, and of course, it is an 



outlet. So, we will be looking for a point and then select the geometric coordinate system. So, 

in the coordinate system, we know we have fixed WGS 84, UTM zone 45 N and then we press 

the OK button.  

 

After creating the outlet point shape file position the outlet in the proper place, we must close 

that in the proper place, and for that we right-click on the outlet then click on the outlet and 

toggle editing, and then create the outlet point this provides the ability to edit the outlet name 

and position of the outlet location.  

 

So, we can select ID give a name or a particular number, and then we can also point out where 

this will be located exactly. 



 

After pointing out the output location there is a need to know the coordinates of the outlet for 

further processing and for that, we right-click on the outlet and open the attribute table open 

the attribute table that is here once you what in the attribute table this is what we get. 

 

 

After opening the attribute table click on the field calculator to know the x and y coordinate 

values. So, this is the field calculator and then it will give us the x and y coordinates. 



 

 So, know x and y coordinate values gives the outlet field name type and length. So, field name 

whatever you have chosen, and then you must give it type and length and so and such as dollar 

x and dollar y for x and y. 

So, it is dollar x and ah coordinates respectively from the geometric tab will give us the 

coordinates.  

 

So, the coordinates of x and y are the x and y coordinates of the outlet ID we provided. So, this 

is here already we know the coordinates.  



 

Now to extract the catchment of the selected outlet we process the upslope area and for that, 

we go to the upslope area put the x and y coordinate values, and then run. So, x and y coordinate 

what values we are putting here, and then we click the run button. 

 

Then two layers have been created one for the selected catchment and the other for the rest of 

the area. 

Now we need to remove the rest of the area. So, here you have two areas this is the watershed 

we selected this is water that we are interested in and this is the other area and we need to 

remove this area. So, for that, we convert the raster layer to a vector layer.  



 

So, here is raster to vector this is here raster layer, and raster to vector we choose and that is 

click on the raster click on the conversion, and then polygonal that is raster to vector,  

 

Then after opening the polygonalized window insert the input and save the output file. So, 

insert the input and this is the output and then we run the Bandra. 



 

After vectorizing, open the attribute table of the vectorized file. 

 

 So, the vectorized file attribute table here, and the attribute table of the vectorized file show 

three expressions, one for the whole area, one for the catchment, and one for the rest of the 

area. Delete the other two. We need to delete the other two, and we are only interested in one 

of them.  



 

After that, extract the selected drainage basin from the whole drainage basin area. For that, we 

go to extraction, that is raster extraction, and clip raster by a mask layer, that is raster extraction, 

and clip raster by a mask layer.  

 

After opening the clipping window, the drainage basin is given as the input layer, which is what 

we are interested in, and then the vectorized file, considering only the selected catchment layer 

is given as the clip layer, and we run it in the background, and then we will get the catchment 

shape. So, this is the catchment shape we are getting exactly here, and the catchment boundary 

shapefile is shown in the figure.  



 

Then we can go for extraction of channels. 

So, extraction of channels, and for that, the channel network is extracted by clicking on the 

polygon clipping window. So, we have to search for clip or polygon clipping, that is what we 

have to look for, and then after opening the polygon clipping window, the catchment shapefile 

is given as a clip feature.  

 

So, here, the catch channel is given as the input feature, so channels are given as the input 

feature, that is what we are interested in, the output feature is then saved, this is the output 

feature that is where we want to save it, and then we click on the run. So, this is what we get, 

the channels of the selected catchment are shown. 



 

So, we are now able to see our catchment as well as the channels. 

 

Then we extract the DEM for the selected catchment. For that, a clip raster by polygon tool is 

needed.  



 

So, for that, after opening the clipped raster by polygon window, projected DEM is given in 

the input file, the catchment shapefile is given as the polygon clip feature, and the output feature 

is saved by clicking on run. 

 

 So, this is the final output of the watershed delineation exercise. As you can see, we started 

with the DEM, and by using different features, finally, we extracted the watershed boundary 

and the watershed channel, that is what watershed delineation is all about. So, that is how we 

have extracted the DEM now. 



 

Now, once we have delineated the watershed, then we can go and play with the morphological 

characteristics of the watershed, that means we can determine the morphological characteristics 

of the watershed, and already just repeat that we had linear aspects, aerial aspects, and relief 

aspects, that is based on limit perimeter, stream order, stream number, bifurcation ratio, stream 

length, length ratio, watershed area, shape, drainage density, stream frequency, watershed 

slope, relief, relief ratio, dissection index, and rugged net index the definition and how they are 

defined that we have already seen in the previous lecture. Now we are just saying using the 

QGIS how to determine them.  

 

So, coming to linear aspects of watershed geomorphology. So, the first thing is the stream 

number. During the watershed delineation, we have calculated the Stahler stream order. So, we 

know what order streams are there and to calculate the existing stream number of different 



orders in the basin we open that attribute table of the channel network. So, we must just open 

the attribute window and here you can see that these are orders channel orders or so near 

channel order different channel order first-order streams are being shown. 

 

Select the order of the stream, let us say stream order number 1 you select, and then after 

selecting the stream in a particular order, export those. So, you must export the selected feature 

here as you can see and for that click on the channel network of the basin, then right-click go 

to the export tab and save selected click on the save selected features.  

 

So, save selected features when we click then we will get the yes save the selected streams in 

a particular order is a shapefile that is here that is first-order dot shape, first-order we have 

selected. In a similar process, we can separate different order streams and save we can do that 

by clicking on the ok button here.  



 

So, after separating the different order streams, we can go to each file and change the colour 

also. So, now, we can see that the first-order is given the green colour, second-order red, third-

order orange, and fourth-order pink. 

So, you can see that it is a fourth-order stream and a fourth-order watershed, and the highest 

order at the outlet is 4. Then, of course, we can count the number. So, for different order 

systems, the number is 45, 13, 2, and 1 for this.  

 

Now, Nu, we discussed Nu, so we obtained that Nu value. So, now, once we know Nu, we can 

calculate the bifurcation ratio easily. 

After getting the total number of streams of different orders, the bifurcation of different orders 

can be calculated with the following equation. We know the numbers, so we can find out the 



values 3.46, 6.5, and 2. So, these are the different values we have obtained of the bifurcation 

ratio using QGIS. Earlier, we discussed how to do it manually also, and Rb should be greater 

than 1. So, that is satisfied in this case. 

 

 Then comes stream length. Stream length can be calculated for each order stream. Of course, 

we must open the attribute table every time. For that, open the attribute table of each order 

stream, and so, it is here. 

 

 The attribute table of each order stream shows the length of each stream in meters. So, different 

orders and different streams are shown here, and we need to calculate the total length. 



 

 To calculate the length, first dissolve all streams into a single stream of a particular order using 

the dissolve tool. 

So, we must use the dissolve tool in this case. Click on the vector here, then click on the 

geoprocessing tool, and then on the dissolve tool. So, from vector geoprocessing and 

dissolution. These are the orders we must click, and after opening the dissolve tool, select the 

different order streams as input. So, first order, second order, and so on. In this case, we say let 

us say we are putting first order streams, and then we run the application. 

 

 To calculate the first order, the attribute table of the dissolve file we must open and open the 

fill calculator, and we can then after giving all the input, length will be calculated. So, the length 

of the first order will be calculated by pressing ok. So, you get here the total length of the first 



order is 153,177 meters. For second order, third order, and fourth order, the other different 

orders, and this stream length we have obtained.  

 

Once we have that, then we can calculate the R L values using this relationship, stream length 

ratio, already discussed. 

Then we come to the aerial aspects, that is the watershed area.  

 

To calculate the area of the watershed, right-click on the watershed file, go to the attribute table 

again, click on the fill calculator, and open. So, here give all the inputs and type the dollar area 

here. Calculate the area of the watershed. So, the watershed area comes out to be this many 

square meters, it is in a square meter. So, you can, if it is square kilometers, it is more. So, it is 

924 square kilometers you will get here.  



 

Then, the perimeter, similarly, to calculate the perimeter, we type dollar perimeter here, and 

then the perimeter is calculated which comes out to be 237,536.91 meters. All units are meters 

here and then go to the attribute table of the watershed to see the perimeter. So, it is here which 

is here and the same thing here. 

 

Then comes drainage density. Of course, for calculating the drainage density, we calculate the 

total length of the streams in the basin. That means we need to dissolve all streams into a single 

layer. So, already we have seen the dissolve function. So, the vector geoprocessing tool, 

dissolved and we dissolved everything into one layer, and then clicked on the run. Then open 

the attribute table of the dissolve file by right-clicking on the dissolve file and after opening 

the attribute table, click on the fill calculator and open, we have to type some length here, some 



dollar length to get the same length, and the total length comes out to be here 312,217.518. 

This is uploaded here.  

 

And then the total length of the stream in the basin is calculated and displayed in the attribute 

table of the dissolve file which we can see here and previously we have calculated the 

catchment area. So, now we know the calculated area, we know the total length. So, we can 

join these two attribute tables, one to calculate the drainage density. So, joining attributes to 

join the two attribute tables, click on vector, then data management, then click on join attribute 

by location and then we give the opening a join attribute location both the files are given as 

input. 

 



 then we run it in the background and the attribute tables of both files are joined and shown in 

one attribute table we will right-click on the new join layer and open the attribute table.  

 

From here the length and catchment area are shown together and then we can calculate the 

drainage density for that total n by catchment area we have to calculate that is the formula we 

know for drainage density and then output the file name field name we are saying drainage 

density. 

 

 

So, when we run, we will get a drainage density of 0.00034. So, that is the answer from QGIS 

for drainage density. Now, open the attribute table again to see the drainage density, and it 

comes out to be 0.0034 per meter area by length. So, per meter, it comes out.  



 

Then, again, in linear aspects of watershed geomorphology, we can also calculate the longest 

flow length. 

That means, most of the things you have known. So, the only thing is that we must open the 

attribute table for the drainage network. 

 

 The longest field of stream we must find basically for that, select the stream manually in the 

attribute table which is the longest flow path. So, stream order 4 is what you are interested in. 

A particular order has the highest length. After selecting the stream within the longest path, 

export these streams in a separate file. For that, right-click on the drainage network file, then 

click on export. So, here drain network file export click on the save selected feature give an 

output file name, and save. So, that is what the error is. So, we are calling it the longest stream 



and the longest flow path consists of many streams. Therefore, there is a need to calculate the 

total length, and that means we need to use a dissolved table. We already know to dissolve 

vector geo-processing, then dissolve, and then by doing that, open the attribute table of the 

longest flow path file, and the total longest flow path will be shown here in meters. 

 

And then, of course, we can calculate the sum length, which of course, the total length here is 

68,147.4777. This is for a particular order. So, the total length after putting this formula, only 

we will get that is the total length.  

 

Then, a watershed length can be calculated by measuring the distance between any two points. 

So, this is the outlet, and we can select along the mainstream the longest one or wherever you 

want to find out. 



So, a point will be selected manually outlet in any point on the perimeter that has the maximum 

distance from the outlet. So, any of the definitions one can use for calculating. So, click on the 

measures line toolbox that is here measures line toolbox and select the point. So, the distance 

between the two points will be shown. 

So, that is 52,457.863 meters. So, any two that let will be fixed, and any point you can select 

and you can get the watershed length.  

 

Watershed width again any two points you can select perpendicular to the watershed length and 

you can calculate and then this will be 24,688.467 meters. Once we have already calculated all 

the different characteristics. 

 



So, various parameters we can calculate. So, for watershed parameters like form factor, we 

know the formula for these values we have already calculated. So, we can calculate the 0.366 

shape factor by putting in the formula and knowing these. So, we can calculate all these. 

So, the shape factor is LW square which is the inverse of that. So, 2.976 because these are all 

we have calculated earlier. 

 

 Elongation ratio A by L. So, the area we know L we know is 6.8 circulatory ratio area and 

perimeter. So, 0.25 is 2.206 compact and rectangular using the following that is P square that 

is it is thus the inverse of circulatory ratio it comes out to be 4.854.  

 



Constant of channel maintenance that is 1 by drainage density we have calculated drainage 

density earlier. So, it is 2941. The stream frequency is calculated earlier because we have the 

number of streams we know the catchment area. 

So, it comes out with 6.71x 10-8.  

 

Then similarly, relief aspects can be calculated that is absolute relief which is the maximum 

relief altitude of the basin. We already know we have the elevations already. So, the maximum 

altitude we know is relief relative relief which is the elevation between the highest and lowest 

points of the valley. 

So, these 2 points we can calculate. So, this value comes out to be 243. Water slope is calculated 

as the elevation difference between the upper and lowest bound over point upper and lower 

point of the main flow path and the length of the main flow path. So, 381 38 these values 

already we know and this is the length of the main flow path. So, it comes out to be 0.0056.  



 

Then relief ratio that is the watershed absolute relief by the longest dimension of the watershed 

parallel to the main flow path. 

Using this value, we get 0.007. Dissection index H/R. So, H value and R value we know. So, 

it comes out to be 0.638. Reagen next index so, Dd times H we know H we know. 

So, it comes out to be 0.084. So, that is how we have seen that from the beginning from 

downloading the DEM to utilizing the QGIS software. I have given you almost a tutorial on 

what buttons have to be clicked, and what has to be typed to be able to extract various features. 

I think if you download the DEM and download the QGIS software and do this exercise, I think 

you will enjoy it. Thank you very much. Please give your feedback and raise your questions or 

doubts we will be happy to answer them on the forum. Thank you. 

 



 


